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1 Revision history

Product version Document Changes/comments
= FieldCare: KAO01303S/04/ | New product version
2.13.xx A2/04.18 DeviceCare: new product version
= DeviceCare:
1.05.xx
s FieldCare: KA01303S/04/ | New product version
2.14.xx A2/05.19
= DeviceCare:
1.06.xx
= FieldCare: KA01303S/04/ | New setups (new components)
2.14.xx A2/06.20 DeviceCare: new product version
s DeviceCare:
1.07 xx
= FieldCare: KA01303S/04/ | New FieldCare product version
. ]2)15)9& . A2/07.20 s Software license management
evicetare: = USB stick replaces DVD
1.07.xx
s FieldCare: KA01303S/04/ | Section 4.3: Note on software update service
2.16.xx EN/08.22-00
= DeviceCare:
1.07.xx
= FieldCare: KA01303S/04/ | New FieldCare product version
2.17.xx EN/09.22-00 « FDI Package support
* DeviceCare: = Security update
1.07 xx yup
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Product version

Document

Changes/comments

= FieldCare:
2.18.xx

= DeviceCare:
1.07.xx

KA013035/04/
EN/10.23-00

New FieldCare product version

s Windows 11 Support

Microsoft SQL Server 2022 Express

Update FDI Package support, Endress+Hauser and
third-party manufacturer

PROFINET CommDTM updated

CDI CommDTM updated

Flow verification DTM updated

Security update of components

Security manual SD03193S

Catalog update, B & R scanning and IO-Link
improved

W@M functionality removed as W@M Portal will
shut down on 31.12.2023.

= FieldCare:
2.19.xx

= DeviceCare:
1.08.xx

KA013035/04/
EN/11.24-00

FXA291 communication driver updated
V2.12.36.4

Softing PROFIdtm updated V2.24.00
Flow verification DTM updated V2.02.00
PROFINET CommDTM updated V1.01.00
Bug fixes

2 About this document

2.1 Document function

The Brief Operating Instructions contain all the essential information from
incoming acceptance to initial commissioning.

These instructions contain all the information needed to install and update the

software.

2.2 Symbols used

Symbol Meaning

Open the start page of the Installation Manager.

Open the language setting.
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Symbol Meaning

Additional information about the software.

Close the application.

Jump back to the last page opened.

Information about FieldCare, modem, Fieldgate, Field Xpert.

Open the keyboard.

Full screen.

Exit full screen.

3 Product description

3.1 Software function

The Installation Manager guides the user through the installation of all the
FieldCare components which are delivered within the FieldCare package (frame
application, driver, CommDTM-files, DeviceDTM-files, tools). Administrator rights
are needed to perform the installation.

3.2 Software license management (SLM)

3.2.1 FieldCare SFE500 licensing model

FieldCare is delivered with a free, time-limited trial license. The licensing
agreement (EULA) applies for the use of the license. If FieldCare is to be used on a
permanent basis, FieldCare must be purchased and the license activated with the
software ID provided.
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The FieldCare licensing model consists of a basic module called "Plant Asset
Management' (PAM) and an extension called "Condition Monitoring". A license
comprises a combination of the PAM module plus any extensions.

To be able to use the current FieldCare version, the software must be
activated with the software ID. The license key of the previous FieldCare
versions (< 2.15.00) can no longer be used for the current FieldCare version.
For more information, visit www.endress.com/sfe500 or contact your local
Endress+Hauser sales partner.

Software license management offers the following functions:

s Use of the software in trial mode for 60 days

= Permanent activation of the software (with or without Internet connectivity)
= License renewal

= Return of the license

Activating the software permanently

Prerequisites:
s The software is installed on the computer
= The licensing agreement (EULA) has been accepted

Activating the software permanently with Internet connectivity

Prerequisites:
The software ID is available

The software ID is located on the label of the USB box containing the
FieldCare USB stick or in the e-mail sent by Endress+Hauser on delivery of
the product.
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1.

2.

3.

Start the software.
=~ The Software activation window is displayed:

Software License Management - FieldCare SFE500 Endress + Hauser (1]

& < _ K

Software Activation
- Trial period -

Warning (SLM-A10): The software is running in trial mode. The
software can be operated with limited capability and capacity. The
trial license will expire in 60 days. Please activate the software.

o]

Click the Activate button.
 The Software license management window for entering the software

ID is displayed.

Software License Management - FieldCare SFE500 Endress-+Hauser (£

f < _ 24

Please enter the Software ID. The Software ID can be found on a
label in the software package.

fioo]

Enter the software ID.
- A symbol confirms the correct software ID has been entered.
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4. Click the Continue button.
Le

Software License Management - FieldCare SFE500 Endress+Hauser (1]

fr < ] < |

To activate the software you need access to the Software Portal.
Please fill in your credentials or register to get a new account.

E-mail address

Password ‘

1 have forgotten my password

5. If you already have a user account for the Endress+Hauser software portal:
enter the e-mail address and password and click Activate.
- The following window appears if the software has been activated
successfully:

Software License Management - FieldCare SFE500 Endress+Hauser (1]

& < I £ (©] 4 A b

Software Activation

The application has been activated successfully.

Details about the license can be found in the menu:
Help -> License Information.

“

6. If you do not yet have a user account for the Endress+Hauser software
portal, return to step 4 and click the Create account button.
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After activation, you can view the license information:

1. Click the Close button.
[

Software License Management - FieldCare SFE500 Endress +Hauser (1]

& < I £ (o) M p4 Y

Software License Management

Product FieldCare SFES00

217.00

FieldCare SFES00 application update service will expire on 7/7/2023 11:59 PM.

Software License Configuration

The window displays all the relevant information for the license, such
as the serial number, licensee etc.

2.  Click the X (f4) in the top right-hand corner to close the window.
- After a moment, the FieldCare program starts.

ﬂ Software license configuration

The Search for remote licenses checkbox can be enabled or disabled. The
option is given for performance reasons. If the checkbox is enabled, the
computer searches for valid software licenses in the network that are offered
by a license server. If the checkbox is disabled, a valid software license must
be installed locally on the computer. The option prevents the computer from
scanning for licenses in the network.

If necessary, the Software license management function can be opened via
the FieldCare menu Help and License information.
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Activating the software permanently without Internet connectivity

If the computer does not have Internet access, the license can also be activated

manually.

Prerequisites:

= A portable storage device, e.g. a USB stick

= A second computer with Internet access

Overview of the manual activation process

file (*.EHC) on USB stick.

Computer with FieldCare, but USB | Computer with Internet access
no Internet access stick
"Software activation - Manual" In the Endress+Hauser software
window portal
Step 1
Action: Save license request file => 1. Activation request
(*.EHR) on USB stick.
Action: Upload license request file
(*.EHR) from USB stick.
2. License activation/update
Step 2 <= | Action: Save license update file
(*.EHU) on USB stick.
Action: Import license update file
(* EHU) from USB stick.
Step 3
Action: Save license confirmation => 3. Confirmation of license

activation

Action: Upload license confirmation
file (*.EHC) from USB stick.
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Detailed description

1. Carry out steps 1 to 4 as described in the section Activating the software

permanently with Internet connectivity.

- The Software activation window is displayed with the message Your

client/server is not connected with the Internet.

Software Activation

Your client/server is not connected with the Internet. Please check

software activation in case this computer/server is not connected
with the Internet.

“

your network connection/settings and try again. Perform a manual

Software License Management - FieldCare SFE500 Endress +Hauser (£

& < _ 224

#mn

2. Click the Manual activation button.
=~ The Software activation - manual window is displayed.

fr < —

Software activation - Manual

Step 1 Step 2 Step 3

Save the Endress+Hauser license Import the license ~ Save the license
request file (*.EHR). Go to a update file (*.EHU) in the confirmation file (*.EHC). Go to a
computer with internet connectivity, ~application to be activated. The file computer with internet connectivity,
log in to the Endress+Hauser has to be created in the Endress log in to the Endress+Hauser
software portal (www.software- “+Hauser software portal software portal (www.software-

duct: com) and start the products.endress.com) and
software activation process by products.endress.com). complete the software activation
manual uploading the file. Save the process by the manual upload of the
Endress+Hauser license update file file.
(*.EHU) in the software portal

afterwards.

10
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3. Click the Save button under Step 1.
= The Windows dialog Save as... opens.

4. Save the license request file (*.EHR) on a USB stick.
Take the USB stick to a computer with Internet access.

6. On this computer with Internet access, go to the Endress+Hauser software
portal: https://software-products.endress.com

Log onto the Endress+Hauser software portal.

8. Select the Activation/update menu.
= The following view is displayed:

x4 EaEm T

€ 5 C O 8 somwareproducsendresscomuifpriate/scivate B % *»O0&

Software Portal Endress+Hauser (2]

Home  Mylienses  Activation/Update  License return

2. License activation/update

3. Confirmation of the license activation/update

nthe product actvation.

9. Under 1. Activation request, click the Upload button.

10. Upload the license request file (*.EHR) from the USB stick.

L= If the upload was successful, the following message is displayed: The
activation request file has been successfully processed. Continue with
step 2 in the Software activation — manual window.
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11.

12.
13.
14.

15.
16.
17.

18.
19.

20.

12

Select OK to confirm the message.
“ The name of the activation file " EHU" is displayed:

B % *»O0&

2022-11-15_14-16-32_DESKTOP-R3K2BFH.EHU

28FH.EHU

Click the Save button.
Save the license update file (*.EHU) on the USB stick.

Take the USB stick to the computer where FieldCare is installed (no Internet
connection). Make sure you do not log out of the Endress+Hauser software
portal. On the computer without an Internet connection, the Software
activation - manual window continues to be displayed.

Under Step 2 click the Import button.
Upload the previously saved license update file (*.EHU) from the USB stick.

Click the Save button under Step 3.
=~ The Windows dialog Save as... opens.

Save the license confirmation file (*.EHC) on the USB stick.

Click the X ([4) in the top right-hand corner to close the window.
- After a moment, the FieldCare program starts.

Take the USB stick to the computer with Internet access. You are still actively
logged into the Endress+Hauser software portal.
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21. Scroll down to 3. Confirmation of the license activation.

Le

@ Sotare o x4
cs>co @

HR). Tip: The file must be created in the

Upload the.
2022-11-15,

DESKTOP-R3K28FH.EHU

 DESKTOP-R3K28FH.EHR

2. License activation/update

v - 8 %

B % *»O0&

22. Click the Upload button.

23. Upload the saved license confirmation file (*.EHC) from the USB stick.

L= If the upload was successful, the following message is displayed: The

activation of the product has been confirmed successfully.

24. Select OK to confirm the message.

FieldCare is now permanently activated. The license status and license details can

be checked on the Endress+Hauser software portal under Products.

Updating the software license

Prerequisites:
= The software is installed on the computer
s The software is licensed

Endress+Hauser
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1. Open the Software license management function via the FieldCare menu
Help -> License information.

- The following window is displayed:

Software License Management - FieldCare SFE500 Endress +Hauser (1]
& < I £ ) .

Soteare Licnae Mansgement

Product FeldCare SFES00

Verson 21700

Sertal number

Software 1D

Leenseusn g Perpetsal

Usage period  This product s licensed.

Maintenance FieldCare SFES00 application update service will expire on 7/7/2023 11:59 PM.

m

Software License Configuration

2. Click the Renew license button.
 The Login to software portal window is displayed.

Software License Management - FieldCare SFE500 Endress+Hauser (2]

& < I £ O] M F4 kY

To update the license you need access to the Software Portal.
Please fill in your credentials or register to get a new account.

E-mail address ‘

Password

1 have forgotten my password

m“

fm
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3. Enter your e-mail address and password, then click Renew license.

Y~ The following window appears if the software has been activated
successfully:

Software License Management - FieldCare SFE500 Endress+Hauser (1]

& < I £ (©] 4 A b

Software Activation

The application has been activated successfully.

Details about the license can be found in the menu:
Help -> License Information.

4. If you do not yet have a user account for the Endress+Hauser software
portal, first click the Create account button in Step 2.

Returning the software license

Prerequisites:

= The software is installed on the computer
= The software is licensed

Endress+Hauser 15



1. Open the Software license management function via the FieldCare menu
Help and License information.

- The following window is displayed:

Software License Management - FieldCare SFE500 Endress +Hauser (1]

& < I £ (O M B4 Y

Software Licenze Management
Product FieldCare SFES00
Version 217.00

Serial number

Software D

Licensee

Liense usa e Perpetual

Usage period s product i icensed.

Maintenance  FieldCare SFES00 application update service will expire on 7/7/2023 11:59 PM.

m

Software License Configuration

2. Click the Return license button.
 The Login to software portal window is displayed.

Software License Management - FieldCare SFE500 Endress+Hauser [

& < I £ (©) M FH i

To return the license you need access to the Software Portal.
Please fill in your credentials or register to get a new account.

Password

I have forgotten my password

m g “

b
100%

3. Enter your e-mail address and password, then click Return license.

b If the software was returned successfully, the Return license window

appears with the message: The software has been successfully
returned.
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4 Installation

Some components take a long time to install. To avoid problems, do not
cancel the installation unless requested to do so.

4.1 System requirements

Before installation, install the necessary software, e.g. Microsoft.NET 3.5/4.x
and PDF Reader.

In database mode, FieldCare versions up to 2.10.xx use SQL Server 2008 for data
archiving. FieldCare versions from 2.11.xx are compatible with Windows 10,
provided that the database is updated at least to SQL Server 2014. A Microsoft SQL
Server 2022 Express is installed with clean installations of FieldCare versions from
2.18.

A clean installation of FieldCare 2.18 is recommended for the Windows 11
operating system. With FieldCare 2.18, a Microsoft SQL Server 2022 Express,
which is an essential requirement for Windows 11, is automatically installed.

Installation and update scenarios supported by version 2.18.xx:

Installed Installed SQL Server | FieldCare FieldCare Procedure
operating database V)
system
Windows 10 | No SQL Server No database | Notinstalled | = Install FieldCare
installed installed 2.18.xx incl. SQL
Server 2022.
= FieldCare
database is clean
installed.
Windows 10 | SQL Server 2014 No database | Notinstalled | = Perform a clean
SQL Server 2016 installed install of FieldCare
SQL Server 2019 2.18.xx.
or = Use existing SQL
SQL Server 2022 Server.
= FieldCare
database is clean
installed.
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Installed Installed SQL Server | FieldCare FieldCare Procedure
operating database )
system
Windows 10 | SQL Server 2014 Database Not installed | = Perform a clean
installed or older install of FieldCare
version 2.18.xx.
= Use existing SQL
Server.
= Existing FieldCare
database is used.
Windows 11 | No SQL Server No database | Notinstalled | ® Install FieldCare
installed installed 2.18.xx incl. SQL
Server 2022.
= FieldCare
database is clean
installed.
1) The SQL Server contains a database that can be used by FieldCare for data archiving.

The FieldCare setup does not support an installation that involves upgrading
the Windows version.

4.2

Software installation

1. Insert the FieldCare USB stick into a USB port and use the Windows file
manager to switch to the root directory.

18
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2. Start the FieldCare installation program (InstallationManager.exe).
[

Installation Manager Endress+Hauser [Z1]

@

[EH) [EH)

FildCare SFES00
oM brary
L hayraprad

ﬂ Options on the Installation Manager start page:
FieldCare SFE500 installation > B 19

= DeviceCare SFE100 installation > B 22
= DTM library installation > & 23

= FDI Package library installation > B 26
= More > B 26

4.2.1 Installing FieldCare SFE500

1. Click FieldCare SFE500 on the Installation Manager start page.
- The"EULA" tab opens.

FieldCare SFE500 Setup Endress+Hauser (2]

D - - - I

Terms and C¢

|
|

EH SWLIC V19 enTXT

1. Genersl

19 Terms and C “Speci License Terme) il 3pply forman:

tegrelpa T =GTC)

of

I caseof any dicrepancis o the appicatle GTC these Special iense Terms shll prevai.

1.2 legally { “Licensee”), and

prior agr 3 not).

8Y ORDERING, ACCESSING, INSTALLING OR USING 7, THE LICENSEE ACCEPTS ALL LICENSE TERMS AND AGREES TO B2 BOUND BY

THER PROVISIONS. UNLESS A SEPARATE WRITTEN AGREEMENT IS SIGNED WITH THE LICENSEE THIS DOCUMENT SOLELY SHALL GOVERN THE LICENSING, USE, DELIVERY,

UPDATES. UPGRADES. MAINTENANCE AND REPLACEMENT OF THE SOFTWARE PRODUCT. =

(O 100NotAgree (O}

Endress+Hauser
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[ 2. SelectIagree to accept the license agreement and click Next.
= The "Path" tab opens.

FieldCare SFES00 Setup Endress+Hauser [Z]
Installation path

C\Program Files (xB6)\Endress +Hauser\FieldCare SFESO0 =
Create shortcut on desktop?
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3. Select the installation path and click Next.
L= The'Install' tab opens and FieldCare is installed.

FieldCare SFE500 Setup Endress+Hauser (2]
Updating

[ Overall Progress -

- Frame -

Following installation, the "Report" tab opens.

FieldCare SFE500 Setup Endress+Hauser (2]

nmn b’

Finalize Installation installed successfuly.

Flow Verification DTM installed successfully.

SFG500 CommDTM installed successfully.

HART CommDTM installed successfully.

NI FF CommDTM installed successfully.

CDI Communication DTM installed successfully.

ISS Flow DTM FXA193/291 installed successfully.

1SS Flow CommDTM FXA193/291 installed successfully.
PCP CommDTM installed successfully.

IPC CommDTM installed successfully.

Softing Profibus CommDTM (64 bit) installed successfully.
Softing PROFIdtm and driver (64 bit) installed successfully.
EH Driver TXU10 V2 installed successfully.

EH Driver TXU10 installed successfully.

EH Driver FXA 291 installed successfully.

EH Driver FXA 195 installed successfully.

EH Driver CDI USB Direct installed successfully.

List and Labels installed successfully.

<

Setup installed s

4. Close the dialog box.

The database password must be changed following successful installation of
FieldCare. The database's standard password cannot be used.
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4.2.2 Installing DeviceCare SFE100

1. Onthe Installation Manager start page, click DeviceCare SFE100.
- The"EULA" tab opens.

DeviceCare SFE100 Setup Endress+Hauser
“ Path Install Report X
1 General
11 These Special License Terms and Conditions for Software Products (hereinafter “Special License Terms") shall apply in addition to and form an
integral part of the General Terms and Conditions of Delivery and Services (hereinafter referred to as “GTC") of the contracting Endress+Hauser Sales
Center (“Licensor”). In case of the 1 L Te hall
12 The License Agreement constitutes a legally binding agreement between Licensor and the customer and/or end user (hereinafter "Licensee’),

and shall take precedence over any inconsistent or conflicting provision in any prior agreement, representation o understanding relating to software
(regardless of whether registration and activation is required or not).

'BY ACCESSING, DOWNLOADING, INSTALLING OR USING THE SOFTWARE, THE LICENSEE ACCEPTS ALL LICENSE TERMS AND AGREES TO BE BOUND
'BY THEIR PROVISIONS, UNLESS A SEPARATE WRITTEN AGREEMENT IS SIGNED WITH THE LICENSEE, THIS DOCUMENT SOLELY SHALL GOVERN THE

LICENSING, USE, DELIVERY, UPDATES, UPGRADE CE AND REPL OF THE SOFTWARE.
1 The Special License Terms further apply to any and all Updates or Upgrades of the Software that Licensor supplies, unless Licensor provides
other License Terms.

14 The Special License Terms do not apply to licensing of the following software products: Software as a Service (SaaS), firmware (embedded

(O 100 Not Agree @ Iagree

2. SelectIagree to accept the license agreement and click Next.
= The "Path"tab opens.

DeviceCare SFE100 Setup Endress+Hauser (1]
Installation path

C:\Program Files (xB6)\Endress+Hauser =

Create shortcut on desktop?

22 Endress+Hauser



3. Select the installation path and click Next.

= The 'Install' tab opens and DeviceCare starts to install.

DeviceCare SFE100 Setup

“mm e

Endress+Hauser (=]

X
Installing
- OverallProgress
B =3 License Validator (64bit)
Following installation, the "Report" tab opens.
DeviceCare SFE100 Setup Endress +Hauser (1]
[ERED 3

Release Notes installed successfully.
DeviceCare SFE100 installed successfully.

4.  Close the dialog box.

4.2.3 DTM library

To be able to access the devices, the required DTMs and DTM libraries must

be selected and installed.

Endress+Hauser
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1. Click DTM library on the Installation Manager start page.
= The "Welcome" tab opens.

DTM library Endress+Hauser (Z1]

You must agree the license terms and conditions before you can install DTM library 2.44.00.

Licence agreement

Al tghts to this software (except Windows" standard software) and to the technical documentation and materials, which
accompany it are the exclusive property of or E has acquired the di rights. Neither this software
nor the associated documentation (written or on data medium) may be duplicated or reproduced in any form, in whole or
in part, without the express written permission of Endress+Hauser

The use of this software is subject to the following terms:

Only the end user is allowed to use the product. He is granted a non-exclusive right to use this software on a single
workstation. Extended use on more than one station (e.g. in a network) is not allowed

The permissible use includes the right to produce of a back-up copy of the program for data security on diskette (o other -

[ 1 agree to the License terms and conditions.

C:\Program Files (x86)\Endress+Hauser\DTM Library

2. Accept the license conditions and click Next.
= The 'System" tab opens.

DTM library Endress+Hauser L]

System validation

Pending system reboot
Check for other installations running
Running applications

Search for earlier DTM Library versions..

v
v
v
v
v

Operating System Version

24 Endress+Hauser



3.

4,

Click Next.

Le

The "Selection" tab opens.

DTM library Endress+Hauser £Z1)
BT T T - ;

Installable Products: Grouped by | Protocol v

PRODUCT INSTALLED VERSION  AVAILABLE VERSION |

4 u cor
4 EthernetiP

» MODBUS
» PCP
» PROFIBUS

[ oo |

Select the products that need to be installed and click Next.
= The "Overview" tab opens.

DTM library Endress+Hauser £7]

Installation Overview:

Following products are subject to (Un)linstall/Update:

PRODUCT INSTALL UPDATE REMOVE SIZE [MB]
Ecograph T/ RSG35 / CDI / FW 2012z v 00 *
!Engytal/RHB/CDI/FW‘OJ.zz v 00 I
ifngytal /RS33/CDI/FW 10422 v 00
|Levelflex / FMP Sx / HART / FW 1.01.2z / Dev.Rev. 2 v -16
|Levelflex / FMP Sx / HART / FW 1.0222 / DevRev. 3 v A3
‘Levelﬂex /FMP 5x / HART / FW 1.03.22 / DevRev. 4 v 42
!wmwrwswmnw 1,002z / DevRev. 1 v 23
S s o=
Total 2 2 0 4221
‘ USED DRIVE REQUIRED SPACE [MB] FREE SPACE [MB] ‘

‘ a\ 427 627309

e o ]

Endress+Hauser
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5. Click Install.

= The DTM library starts to install and displays a message to confirm that
installation was successful.

6. Click Close.
= The start page of the Installation Manager opens.

4.2.4 FDI Package library
In order to access the devices with FDI Packages as device drivers, you must

first install the necessary FDI Packages or FDI Package libraries.

1. Click FDI Package library on the Installation Manager start page.
2. Follow the instructions on installation.

425 More

» Click More on the Installation Manager start page.
- The dialog box with the selection options opens.

Installation Manager Endress+Hauser (]

A o] 2 X

o o H
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DTM library

» Click DTM library.
L~ All available DTMs are displayed.

Installation Manager Endress+Hauser (]

A o] 2 X

DTM library

. M- e
= S .

Communication/Gateway DTMs

» Click Communication/Gateway DTMs.
=~ All available communication/gateway DTMs are displayed.

Installation Manager Endress+Hauser [Z1]

&

Communication / Gateway DTMs

Endress+Hauser 27



Documentation

» Click Documentation.
= All documents are displayed as PDFs.

Installation Manager Endress+Hauser (]

&

Drivers

» Click Drivers.
= All available drivers are displayed.

Installation Manager Endress+Hauser (]

A o] 2 X

(Edi)

[T —

[Ed}

o TXUI0V2 modem
Bl v
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Tools

» Click Tools.
- All available tools are displayed.

| Installation Manager Endress +Hauser [Z1]

Tools

4.3 Updating the software

Endress+Hauser offers an update contract for FieldCare.
Contact your Endress+Hauser sales partner for further information.
ﬂ Software update service

The inclusive maintenance period starts with the creation of the license and
ends automatically after one year (expiry date). Regardless of when the
software update service is purchased, any additional software update service
purchased will continue without interruption from the last expiry date. If
purchased after the expiry date, the new maintenance period will first cover
the gap in service created between the expiry date and the creation of the
purchased software update service.

It should also be noted that software updates can also be activated at a later
point in time, provided that the software release was issued within a valid,
active maintenance period.

Subscribing to product information
1. Enter https://software-products.endress.com in the web browser.

2. Log onto the Software Portal.
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3. Inthe Software Portal, click My account.
= The "My account" dialog box opens.

Software Portal lete solution for managing your softwar Endress+Hauser (1]

4. Scroll down, select I agree to receiving marketing communication
information like available updates from Endress+Hauser and click Save.

Y~ You have subscribed to product information.

4.4 Updating the device catalog

The FieldCare device catalog must be updated following the installation of
new DTMs or FDI Packages.

Prerequisites:

= FieldCare has been installed

= The software ID has been entered and the software has been activated
= The DTMs or FDI Packages have been installed

1. InFieldCare, click Device catalog and Update.

- The "Update device catalog" dialog box opens. The window on the left
shows the DTMs or FDI Packages that are not included in the device
catalog. The window on the right shows the DTMs or FDI Packages that
are in the device catalog.

2. Click Update.
Y The installed device drivers are updated.

3. Using the right mouse button, click the left window and select Add all to
DTM catalog.

~ The DTMs, iDTMs and FDI Packages are added to the device catalog.
4. Click OK.
= The changes are accepted and the dialog box closes.
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